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IMAGE CAPTURE

1) Camera set up
a) Use a DSLR camera
b) Memory card – in camera and images sent to it – or if you are connected to a computer set up the folders where the images will go ahead of time
c) Lock all camera settings on manual mode
i) Manual settings
ii) Set to shoot RAW
iii) Turn OFF auto-rotate
iv) Crop aspect ratio to FULL
v) Grid display 3/3
vi) Sensor cleaning OFF
vii) Image stabilization OFF
d) Determine your exposure
i) Set your ISO (usually 100 to start depending on situation)
ii) Set your F-stop (usually start around F-11 depending on situation)
iii) Set your shutter speed (usually 1/15 depending on situation)
iv) Check exposure using the histogram on the image after you have taken a test shot and adjust above settings accordingly
v) Once satisfied, record all of this information in field notebook
e) Depth of field calculation (optional – will help determine focus)
i) On your depth of field calculator enter the information above (ISO, F-stop, shutter speed, and camera model)
(1) Will tell you how far/close you can be to subject and remain in focus
f) Focus your subject
i) On auto-focus
ii) Focus on a spot app. 1/3 of the way into your subject, push focus half-way down – captures focus
iii) You should hear a beep when the focus is captured (if using Canon model camera)
(1) Switch to manual focus and tape lens to ensure you do not knock it during the process
(2) Take a test shot to check focus
(3) Now you are in the calibration setting you will be using for the shoot
(a) If your calibration set changes – go through steps c-e again and make note in your field notebook when the calibration changed, this will be important when going back through images
2) Subject Set-up (Lab/Field)
a) Small subject in lab
i) Place subject on turntable with camera at appropriate distance based on the photography plan you have determined before shooting the subject (should provide maximum coverage of all different angles of your subject)
ii) Move the turntable to test that the subject remains stable when rotated and to ascertain that the subject remains within the camera’s visual focus and centered in the image when rotated (using the grid display on the camera is helpful in this regard)
iii) Put 36 markers around the turntable at 10° intervals (this is where photos will be taken)
iv) Ensure background does not have any interference – should be a background color that contrasts objects, makes it easier for the program to separate out the object from the background when masking
(1) i.e. dark object use light background/light object use dark background
(a) A solid colored backdrop (such as a monotone velvet cloth) is recommended
v) Lighting
(1) Set up two photography lights on either side of the subject
(2) Position lights so that the subject is illuminated and limiting shadow as much as possible
(a) Adjust lights as necessary between circuits
(b) Take a test shot to test the lighting and adjust if necessary
vi) Scale bars/color card do not need to be included in the circuit photos, but MUST be included in the flat run (see below)
b) Large subject in field
i) Determine a path around your subject that allows for 2/3 overlap of shots on flat surfaces, and 15 degrees movement around corners
(1) Path must remember to include depth of field so entire subject is in focus
ii) Place flags to mark path
iii) Set up 4 scale bars around the subject
(1) Can be farther away from the subject depending on environment (2/3 overlap shots can match them to the subject)
iv) Set up grey/color card
3) Subject Capture
a) Move along the set path – whether in the lab or field - taking photographs at determined intervals (done in step above)
i) When shooting a subject on a turntable, using EOS Utility on the computer to shoot remotely is recommended; it helps prevent jostling of the camera
b) Need at least three paths around each subject
i) Camera landscape and angled straight ahead
ii) Camera above, turned 90 degrees, and angled down
iii) Camera below, turned 270 degrees, and angled up
[image: http://culturalheritageimaging.org/IMAGES/04.jpg]
(1) Angling is necessary to prevent distortion
(2) It might be necessary to do more than three circuits depending on shape of subject, going over top of something just ensure there is enough overlap on photos – OVERLAP IS KEY, this is how the software combines images
(a) For small subjects, such as most in Bryn Mawr College’s Artifact Collections, five circuits are recommended, but often more are needed, again the key is make sure every aspect of the object is captured
(i) Camera landscape and angled straight ahead
(ii) Camera above, 90 degrees, and angled down
(iii) Camera above, 90 degrees, and angled down, with the subject inverted
(iv) Camera below, 270 degrees, and angled up
(v) Camera below, 270 degrees, and angled up, with the subject inverted
1. THESE ARE SUBJECT TO CHANGE – THE CIRCUITS SHOULD BE DETERMINED BASED ON THE SHAPE OF THE OBJECT BEING PHOTOGRAPHED
c) Each time you change the focus on the camera (should only be done between circuits) make a note that it is a new calibration set, this becomes important when it comes time to import the photos into agisoft
d) For circuits – make sure to take one shot of the setup with a color card and one shot of the setup without your subject, this will be used to mask the photos during processing
i) This must be done for every circuit – at the end of each circuit you should have 38 photos (36 for the 10 degree intervals, one with the color card, and one of the set up without your subject for the mask)
[image: http://culturalheritageimaging.org/IMAGES/05.jpg]
(1) It is important to note that you can take more/less photographs per circuit depending on the shape of the object and the level of precision you want in the model
(a) More photos = higher precision
e) If scale bars and color cards are separate from subject or for small subject in lab, shoot in the scale bars doing passes above them (also known as a flat run)
i) Use three scales for better accuracy
ii) If done by hand, adjust shutter speed (usually to 1/90, depending on the situation) and F stop (usually to F8, depending on the situation)
iii) Adjust lighting so that movement above the subject does not result in shadows
iv) Take three passes of photos (using the same angling as discussed above)
f) For flat run either in the field or for the scale bars/color card with the objects in the lab take photographs following these steps:
i) Camera straight ahead
(1) Using the 3/3 grid display on the camera, adjust camera position so that subject only appears in the rightmost ⅓ of the view. Take photo
(2) Move right so that the view has ⅔ overlap of the subject. Take photo
(3) Continue process, moving right, until the last photo only has the subject in the leftmost ⅓ of the view
ii) Camera above, 45 degrees, and angled down
(1) Using the 3/3 grid display on the camera, adjust camera position so that subject only appears in the rightmost ⅓ of the view. Take photo
(2) Move right so that the view has ⅔ overlap of the subject. Take photo
(3) Continue process, moving right, until the last photo only has the subject in the leftmost ⅓ of the view
iii) Camera above, 135 degrees, and angled down
(1) Using the 3/3 grid display on the camera, adjust camera position so that subject only appears in the rightmost ⅓ of the view. Take photo
(2) Move right so that the view has ⅔ overlap of the subject. Take photo
(3) Continue process, moving right, until the last photo only has the subject in the leftmost ⅓ of the view
[image: http://culturalheritageimaging.org/IMAGES/03.jpg]
g) Ensure gray/color card captured in your photographs
h) For more detailed shots it is possible to move closer to the subject
i) Rule of half – can either move half the distance towards the subject and use the same lens mm; or stay same distance and change lens mm by half
(1) This will change camera calibration settings (see above)
ii) General rules are the same otherwise
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IMAGE PRE-PROCESSING (IMAGE ADJUSTMENT)

1) Photo download/folder organization
a) If you are using a camera card, download the photos from the camera – if you shot in the lab and connected the camera to the computer, folders should already have been set up (see below) and the raw files should be in the appropriate folders
b) Create folders for the project
i) Top Folder (x1)
(1) Title: Bronze Mirror Files
ii) Sub Folders (x4)
(1) Raw Images
(2) DNG Images (if you want to back up your data, otherwise it is not necessary to save as DNGs)
(3) JPG/TIFF Images (these are the photos that you will be uploading to agisoft – it accepts either file format so either is ok, you do not need both)
(4) Model Files
[image: C:\Users\mjameson\Desktop\Folder Setup.png]
iii) Folders within the subfolders (for however many circuits you have – make a new folder in each of the Raw, DNG, and JPG/TIFF folders)
(1) For example if you have 6 circuits and 1 flat runs, these 7 folders should be reproduced in the Raw (where the images will already be sorted from when you took the pictures), DNG, and JPGTIFF folders
[image: C:\Users\mjameson\Desktop\Folder Setup2.png]
2) Photo Processing in Camera Raw
a) Open raw images in Adobe Bridge
b) Copy color card photo if not included in every circuit
i) It might be necessary to copy a photo that includes the color card and add it to each of the folders if you did not include this step in your circuits above. This is important for the color balance, then before saving the photos this image can be deleted since it is not technically part of the circuit
c) Select Images and Open them in Camera Raw (Ctrl R) or right click  open in camera raw
d) Make sure all tabs in the tone curve are at zero
e) Make sure all of the tabs under Sharpening are at zero or as close as possible
f) Make sure all of the tabs under greyscale are at zero
g) Make sure all of the tabs under split toning are at zero
i) It is possible to save all of these settings as a “zeroed out” preset in Camera Raw, when you come back to edit your next set of photos it will be there, you can select all images and go to “apply preset” and choose the “zeroed out” settings you created with all of the adjustments listed above – THIS DOES NOT INCLUDE LENS CORRECTION OR COLOR CORRECTION – HAS TO BE DONE EACH TIME
ii) You can move through these tabs as shown in the image below
h) Make sure all of the tabs under camera calibration are at zero EXCEPT for temperature and tint, do not change these
[image: 2017-06-12_1334.png]
i) Under Lens Correction, select Enable Lens Profile Corrections, and select the camera make and model and lens used.  If you can’t find it, then deselect Enable Lens Profile Corrections.
i) Distortion to 0; vignetting ok to keep as is
[image: C:\Users\mjameson\Desktop\Profile Correction.png]
j) Color correction
i) Select the “Select All” tab if you have multiple images (ctrl+A)
ii) Resize (enlarge) the image view so the greyscale is large enough to select it.
[image: ]
iii) Use the hand tool on the toolbar at the top to move the color card into view. Specifically, you want the gray square next to the white square, as shown below.
[image: ]
iv) Color correct by selecting the dropper tool (the white balance tool) and position it over the gray square and click (you may notice the color of the image change somewhat).
(1) Hit TAB button 4 times until the “exposure” is selected – DO NOT MOVE YOUR MOUSE DURING THIS PROCESS (if you do, move it back to hover over the second gray square so that the RGB values of this square are visible)
(2) Adjust the exposure settings using the “up” and “down” arrow keys until the RGB values (red/green/blue) are all at 200 or as close to 200 as possible
(a) These are the values for the second square of the color card that we selected with the color balance tool
[image: C:\Users\mjameson\Desktop\Color correction.png]
3) Saving the photos in Camera Raw
a) Delete the image of the color card if it is not part of the circuit
b) Select all the images if you have multiple and then at the bottom select the Adobe RGB tab and change it from 8 bit to 16 bit (sometimes it is already at 16 bit and this does not have to be done)
[image: 2017-06-12_1325.png]
c) Select all (ctrl+A) and click “save images” at the bottom left of the screen
i) Select the destination where the file is to be saved – see folders created above
ii) Select “Document Name” under File Naming to give the .jpg (this can be jpg or tiff – agisoft accepts both file types) file the same name as the corresponding Raw file – i.e. Chinese Mirror – can also give it three number designation starting at 001
iii) Select lower case .jpg under “File Extension”.
iv) Select Maximum under “Quality”.
v) Select “Save” and the .jpg files will be created.
vi) If you want to back up your data as digital negatives, repeat the process but this time select lower case .dng under “File Extension” and select “Embed original raw file” – give these the same name but save them in the DNG folder you created above
(1) At the end of the saving process you should have created jpg/tiff and dng files for ALL of your circuits/flat runs – it is the jpg/tiff file that will be uploaded to agisoft in the next step
d) Repeat this entire process for all of the Raw photos in all of your different circuits/flat runs
[bookmark: ptanzoweeln][image: C:\Users\mjameson\Desktop\Saving.png]
IMAGE PROCESSING (MODEL BULIDING)

1) Agisoft PhotoScan Professional Set Up
a) First, go to “View” > “Panes,” and Select the following panes to be visible: Workspace, Reference, Photos, Console, Toolbar.
[image: Picture1.jpg]
b) Organize those panes so they are all visible. Reference, Workspace, and Toolbar are the most important.
2) Adding the Photos
a) If all images were captured in one calibration set, then you can add them all in one “Chunk” by using the ‘Add Images’ button.
[image: Add_images.png]
i) Once you add your images, they will appear as “Chunk 1”
b) If the images were captured in multiple camera calibration sets (i.e. multiple circuits), then you need to add them in different folders. 
i) Add images using the same button as before. The first group of photos will go in “Chunk 1”. 
ii) Then press the small arrow next to “Chunk 1,” which will open to show you “Cameras” (these are the images). Right Click on the “Cameras” folder and select “Add Camera Group.” This will put a new subfolder in the Cameras folder. 
iii) Select the photos you previously added and drag them into the “Group 1” folder. 
iv) Right click on the “Cameras” folder again and select “Add Camera Group” again. This will create a second subfolder, “Group 2.” 
v) Right click on the “Group 2” folder and select “Add Photos.” Select the photos you want to add for this calibration set.
vi) Repeat as necessary for the number of calibration sets you have. 
(1) You can rename these folders by right clicking on the folder and selecting “Rename.” You can also rename the “Chunk” by right clicking on it and selecting “Rename.” At this point in the process, rename the chunk as “Aligned Subject Name.”

[image: Group_Images.png]
c) Now, check if these camera calibration sets are recognized by the program by going to “Tools” > “Camera Calibration.”
d) This will bring up a popup menu that will show the calibration sets recognized by the program, such as here: [image: Camera_Calibration.png]
e) If the same camera was used, but with a different focus, the program will not recognize the images as distinct calibration groups. 
i) To separate into distinct camera calibration groups, right click on the selected images and “Create Group,” which creates a new group
ii) There should be as many groups as times you changed settings on the camera during your shoot (i.e. focus, shutter speed, F-stop, ISO). 
3) Creating Masks
a) You only need to create masks for the images you shot in circuits – this is because the background is staying the same while the position of your subject is changing relative to that background, because of this you want to mask out the background so the program knows to only align your subject. If you are shooting by moving around a stationary subject, you do not need to worry about masking.
b) Click on the “Photos” pane so you can see your photos  select the first image in circuit 1 and right click and under “masks” select “import mask”
i) This is a test run for the tolerance you will use for the circuit
ii) Replacement – tolerance at 50 (good to start here – can see how it is and then raise it/lower it as necessary) – select “ok” and then choose the appropriate file for the background of circuit 1 (this should be the last photo in the circuit that you took without the subject)
iii) You want the mask to take out as much of the background as possible while leaving in as much of your subject as possible, sometimes it will not be perfect but using the select tools on your toolbar you can add/subtract from the mask as necessary
c) Once you have determined the appropriate tolerance, select all the images from circuit 1  right click  masks  import masks
i) Dialogue box will appear  replacement, from file, tolerance at desired number (should know this from test above)  here you need to ENTER THE FILE NAME EXACTLY OF THE BACKGROUND PHOTO
(1) Ex. Chinese Mirror Circuit 1_037.tif
ii) Apply to all selected cameras and this time select the entire “circuit 1” tiff/jpg folder
iii) This should take a couple of minutes, when it is done you can select the “masks” button at the top of the photo pane to see if the masks were applied properly
d) Repeat these steps for all of your circuits
e) Do not need to mask the flat run with scale bars/color card
4) Photo Alignment
a) “Workflow” > “Align Photos.” Keep the accuracy at “High.” Deselect “Generic Preselection” if you have multiple camera calibration sets or different cameras were used (it does speed up the process for small, simple projects). Adjust the key point limit to be 60,000 (can be between 40,000 and 80,000) and the tie point limit at 40,000 (can be between 20,000-40,000) – basically this tells the program how many points to look for on each photo, do not want it to be too high or this step will take far too long
b) ALWAYS deselect “Adaptive camera model fitting.”
c) If you made masks, select “Apply masks for Key Points.” 
d) Now go eat lunch, this step takes a while depending on the size of your project. 
e) After alignment complete, check the number of photos that aligned. 
i) If all aligned:
(1) You should right click on the Chunk and select “Duplicate.” 
(2) Rename this duplicated chunk to be “Optimized.” (Note: the chunk you are working in is bolded. Double click on a chunk to switch to it.)
(3) Save project again.
[image: Align_Photos.png]
ii) If not all aligned, check to see what images did not align
(1) You can try to align the images within a certain calibration set (Group folder) by right clicking and selecting “Alight Selected Photos.” If that works, great.
(2) If a large amount of photos did not align, you may need to move those photos into a separate chunk and align them separately. This is often the case when there is not enough overlap between the top of the object and the bottom (i.e. if it is flat like a mirror/coin). Follow the steps below and align the top and bottom separately, then place markers on the two chunks to align them together.
(a) Right click on the chunk (Chunk 1 or your renamed Aligned chunk) and select “Duplicate.” 
(b) Rename the new chunk to be Object Set 2
(c) Select and remove photos from Object Set 2 that aligned in “Aligned” chunk.  
(d) Go back to the “Aligned” chunk and select and remove photos that did not align and are now represented in Object Set 2. 
(e) Back to “Object Set 2” chunk.
(i) “Workflow” > “Align Photos” following the same steps as above. 
(ii) Take a short coffee break while those align.
(iii) Did all of those photo align? 
1. If so, great! Move on to the next sub-step. 
2. If not, try to align smaller groups within the chunk or check to see if the images are very blurry (if so, remove the blurry images and try aligning again).
(iv) Align the two chunks by going to “Workflow” > “Align Chunks.”
1. In the pop-up, select the two chunks you want to align (“Aligned” and “Object Set 2”). 
2. Method should be “Point Based.” High accuracy and point limit around 60,000. Do not select “Preselect image pairs.” Select “Constrain features by mask” if you have masked the objects (see above under mask). 
a. You can also align them by place your own markers on the photos from each set (top and bottom) on part of the object that is recognizable in both. Then choose – marker based alignment
3. Take a break, enjoy a snack, come back when it has aligned.
4. The new aligned “Chunk” will be saved as a third, new chunk, which you can then rename. Continue working in this new chunk. 
5) Optimization
a) IT IS IMPORTANT TO NOTE THAT ALL OF THE OPTIMIZATION STEPS BELOW IMPROVE THE QUALITY OF YOUR MODEL, IT IS POSSIBLE TO ADJUST THE NUMBERS LISTED BELOW ACCORDING TO HOW PRECISE YOU WANT THE MODEL – UP TO THE USER, THESE NUMBERS ARE SUGGESTED BY CHI AND PROVIDE A GOOD STARTING POINT
b) In your “Reference” Pane, scroll to the side until you find the “Projections” and “Error (pix)” columns and drag them over to be next to your “Cameras” column. 
i) You will keep an eye on both of these columns as you optimize and do gradual selection steps below, ideally you do not want the projections on each individual photo to fall below 100 as you move through the following steps
[image: C:\Users\mjameson\Desktop\Reference.png]
c) After alignment, click “Tools” > “Optimize Cameras…” (“Optimize Cameras Alignment”). Use the default ones already checked (Fit f; Fit cx, cy; Fit k1; Fit k2; Fit k3; Fit p1; Fit p2) and select OK. 
i) You can also optimize cameras by selecting the wand tool at the top of the reference pane (see image above)
[image: C:\Users\mjameson\Desktop\Optimize Camera alignment.png]
d) “Model” > “Gradual Selection.” Select “Reconstruction Uncertainty.” 
i) Set the value to around 10 (might have to play with this). It is okay if this selects up to 50% of the available points. Press OK
ii) Delete the selected points (appear pink) by pressing the X on the toolbar. 
iii) Optimize the photos again (same settings as above).
[image: C:\Users\mjameson\Desktop\Reconstruction uncertainty.png]
e) “Model” > “Gradual Selection.” Select “Projection Accuracy.”
i) Set the value to around 2-3 (decimals, such as 2.5 work as well).
ii) Okay if up to 50% of available points are selected (but increase the number if nearly all are selected). Press OK.
iii) Delete the selected points. 
iv) Optimize the photos again (“When in doubt, optimize!”) with the same settings as above
[image: C:\Users\mjameson\Desktop\Projection accuracy.png]
6) Scale Bars
a) In the “Reference Pane” click on the “Settings” icon
i) Change Tie Point accuracy (pix) from 1 to 0.1
ii) Change Scale Bar accuracy (m) to 0.0001 if using the CHI Scale Bars.
iii) Press OK.
[image: C:\Users\mjameson\Desktop\Reference settings.png]
b) “Tools” > “Markers” > “Detect Markers.”
i) If using coded targets, select Circular 12 bit at a Tolerance of 50 (with both lower check boxes deselected). 
ii) If using non-coded targets, select cross (non coded) or circle (non coded) based upon which is appropriate (usually cross), with a Tolerance of 50. 
(1) Note that this will place markers at every cross or circle in the images and you may need to manually go back and adjust these. 
[image: C:\Users\mjameson\Desktop\Detect Markers.png]
c) In “Reference Pane” move “Error (pix)” and “Projections” to where both are visible next to the Marker numbers. 
i) Sort by Projections to see how many projections are at each marker. If any are below 9, you may need to remove that marker, but first check out the errors
ii) Sort by “Error (pix)” and see if there is any particular marker with high error. 
[image: C:\Users\mjameson\Desktop\Markers.png]
d) Right click on a marker and select “Show Info.” 
i) This will pull up images in the image pane that include that particular marker. 
ii) If you double click on one, it will pull it up in your workspace. 
iii) This is important, because if you need to adjust markers that were placed by the non coded method, you can now see them in the images.
iv) If you want to remove a marker from an image, put your cursor over the marker (it will turn red) and right click, “Remove Marker.” This will remove it from this specific image.
v) If you want to remove a certain number marker from all images, right click on the marker in the “Markers” section of the “Reference” pane. 
(1) Note: to go back to your model, close out the photo tab in the workspace (or click “Model”). 
[image: C:\Users\mjameson\Desktop\Markers show info.png][image: C:\Users\mjameson\Desktop\Point 1.png]
e) Select two points that form a scale bar (their numbers may not be consecutive), right click and select “Create Scale Bar.”
i) In the “Scale Bar” section of the “Reference” pane, you can double click in the “Distance (m)” column to enter in the known distances of each scale bar.
ii) If you leave one blank, you can use it as a control by clicking on the third calendar icon with a blue “I” and then pressing the “refresh” icon. 
(1) You can check this distance with the known distance and look at the accuracy levels now. 
(2) If it is very off, you may have a blurry picture, a misplaced marker, or an error in the numbers you typed in. 
7) Back to Optimization
a) “Model” > “Gradual Selection.” Select “Reprojection Error.” 
i) Use the sliding scale to select around 10% of the points. Press OK.
[image: C:\Users\mjameson\Desktop\Reprojection error.png]
ii) Delete the points.
iii) Go to optimize (“Tools” > “Optimize Cameras”) and this step onward, add Fit k4, Fit b1, Fit b2, Fit p3, Fit p4 (everything by the “fit rolling shutter”) before pressing OK.
(1) Note: sometimes Fit p3 and Fit p4 are grayed out and cannot be checked (this is okay, continue). 
[image: C:\Users\mjameson\Desktop\New optimized.png]
b) Repeat this step until all pixels with a “Reprojection Error” above 0.3 pixels have been removed.
i) You can see this in the Reference Pane. 
ii) If the number of projections on a photo goes below 100 for any photo used, you may lose that photo in your model. If you need to check a photo with low projections, double click it in the reference pane, which will open it in a separate tab in the workspace. 
iii) You can remove problematic photos by right clicking on the image and selecting “Remove Camera.”
iv) Check overall project error, by right clicking on the chunk and selecting “Show Info” (at the very bottom of the list). 
(1) Your RMS reprojection error should be around 0.1. 
8) Dense Cloud
a) Right click on the Chunk and duplicate it. Rename new chunk as “Model.”
b) “Workflow” > “Build Dense Cloud.” 
i) Select Quality (if creating a mesh from model, “Low” is acceptable, or if you are trying to run something very quickly. Generally select “High.”)
ii) Under advanced, depth filtering should be “Aggressive.”
iii) Take a short break as this builds up. 
iv) Once it is complete, you can see it by selecting the dense cloud with color or without color icons on the toolbar (matrix of nine squares). 
v) You might need to delete extra points that are not part of your model, you can do this by choosing the “select” tool from the toolbar, selecting the necessary points and clicking the “X” to delete them
[image: C:\Users\mjameson\Desktop\Dense cloud.png]
9) Mesh
a) “Workflow” > “Build Mesh” with “Arbitrary” surface type and “High” face count (can select low or medium if building a quick model). 
b) Under “Advanced” select calculate vertext colors and have interpolation enabled (default)
c) Select ok to build mesh
10) Textured Model
a) “Workflow” > “Built Texture” with “Generic”; “Mosaic”; Texture size 4096 x 1 or x 2, as appropriate.
b) Under “Advanced” select enabled color correction and enable hole filling
c) Select ok to build textured model
[image: C:\Users\Matthew Jameson\AppData\Local\Microsoft\Windows\INetCache\Content.MSO\F4615490.tmp]








11) Exporting the model
a) File  export model  save as .obj file (this gives you the model along with overlaying texture)  save in appropriate location


12) Video on Computer Processing that might be helpful
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